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1. Setting up the Relaxation System
Please read through the whole manual until you 
are familiar with it before you start working with the 
equipment.

1.1 Unpacking
Unpack everything (oven, amplifier box, computer, rigs 
and eventually other accessories) carefully and set it up 
on your bench/table. A suggestable set-up is found on 
the picture on the front page of this manual. 

If the optional extension cords was not included in the 
purchase, place the amplifier box right behind the oven 
instead of at the side of the oven.

1.2 Setting up the cell oven
Place the cell oven on a stable and horizontal bench.

Connect the oven to a grounded mains outlet of  
220–240 VAC having a 10 A fuse (alternatively 110–120 
VAC 20 A fuse).

1.3 Setting up the computer  
Connect the computer and its accessories to each other 
and the power source (preferably to an UPS).

1.4 Setting up the amplifier box,  
EB 02.14
Connect the amplifier box to the computer and the 
power source (preferably to an UPS).

The amplifier box for data connection consists of 
WAGO-modules for load cells and temperature sensors.

The box has a network output and can be connected 
directly to the network connection on your PC or to your 
local network.

The box is assigned to the IP-address 192.168.10.91 at 
delivery. If you are already using this IP-address in your 
network, the address must be changed. To change the 
IP-address, use the WAGO Setup software from the USB 
drive in the folder Install/WAGO. Be sure to mark up 
the box with the new IP-address since the only way to 
connect to it is by knowing the exact IP-address.

If troubleshooting connection issues, it may be helpful to 
know this:

	 •	 The amplifier box does not have a power indicator,  
		  but it is possible to peek inside the box and see if  
		  any lights (LEDs) are lit.

	 •	 Newer amplifier boxes have a web server which  
		  can be accessed by entering the IP-address in a  
		  web-browser.

	 •	See chapter 9.2.4 for more details of how to  
		  connect an acquisition box.

Computer 
IP address: 192.168.10.90

EB 02.14 
IP address: 192.168.10.91

Alternative 2

Computer Switch/Hub EB 02.14 
IP address: 192.168.10.91

Alternative 1
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2. Rigs for continuous measurement of stress relaxation
2.1 Rig for compression testing  
(in air), EB 02
The EB 02 rig for temperatures up to 200 °C complies to 
ISO 3384 and other equivalent standards.

2.1.1 Temperature sensor 
The temperature sensors are PT 100 elements. When 
testing compression in air the temperature sensor is 
placed in the bottom of the compression platens to get a 
temperature reading as close to the sample as possible. 

2.1.2 Load cell 
The load cells are Z-type load cells of steel with an 
accuracy class of 0,1 %. Default load cell will have  
600 N as force range (if not anything else is specified  
on the order).

2.1.3 Compensation for the spring  
effect in the load cell
When doing very accurate measurements it may be 
necessary to compensate for the spring effect in the load 
cell. The spring effect is caused by the load cell slightly 
returning as the rubber sample relaxes, thus actually 
increasing the compression of the test specimen. All 
load cells are deformed when a force is applied. It is this 
deformation which is measured to read the force.

When doing comparative tests it may not be necessary to 
do any compensation.

2.1.4 Mounting and adjustment of the 
dial gauge
Loosen the small hexagon locking screw that holds the 
gauge holder to the rig and adjust it so that the gauge 
will be placed right over the support plate. Loosen the 
small hexagon locking screw in front of the gauge holder 
and place the gauge in place and tighten the screw again, 
be careful so you won’t tighten it too hard. If necessary 
adjust the height of the gauge holder.

The dial gauge has a span of 10 mm. If you are using 
specimens below 10 mm in height, adjust the gauge to 
read 0 mm when the compression platens are together. 
When using specimens with a height of 5 to 15 mm, 
adjust the gauge to read 0 mm with a 5 mm gauge block 
between the platens, and add 5 mm to the readings.

The dial gauge is moved by loosening the hexagon 
locking screw in the holder.

	 Note: When tightening any hexagon locking screw  

	 in the rigs, do not tighten too much, just very light,  
	 to avoid marks in the rods.

Rig for testing in compression.
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2.2 Rigs for tension testing (in air), 
EB 02TE
The EB 02TE rig for temperatures up to 200 °C complies 
to ISO 6914 and other equivalent standards. 

If relaxation testing is done in tension the rig is 
equipped with a pair of grips allowing the test strip 
to have a maximum width of 30 mm. No dial gauge is 
used when testing in tension. Instead the elongation is 
measured by the number of revolutions with the rigs top 
screw. One full revolution equals to 1 mm movement.

2.2.1 Temperature sensor 
The temperature sensors are PT 100 elements. When 
testing in tension the temperature sensor is placed close 
to the sample to get a temperature reading as close as 
possible to the sample. 

2.2.2	 Load cell 
The load cells are Z-type load cells of steel with an 
accuracy class of 0,1 %. The load cell for tension testing 
has by default a lower force range (100 N) than the 
compression load cell. 

2.2.3	 Compensation for the spring  
effect in the load cell
When doing very accurate measurements it may be 
necessary to compensate for the spring effect in the 
load cell. The spring effect is caused by the load cell 
slightly returning as the rubber sample relaxes, thus 
actually increasing the stress of the test specimen. All 
load cells are deformed when a force is applied. It is this 
deformation which is measured to read the force.

The software will automatically compensate for this in 
the logview. In the log file Viewer strain compensation 
can be turned on or off, see 9.4.19 Turn strain 
compensation off.

When doing comparative tests it may not be necessary to 
do any compensation.

	 Note: When tightening any hexagon locking screw  
	 in the rigs, do not tighten too much, just very light,  
	 to avoid marks in the rods.

Rig for testing in tension.
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2.3 Special rigs
There are different kind of special rigs available as well.

2.3.1 Rig for compression testing in  
high temperatures (+300 °C), EB 02HT
The EB 02HT rig for temperatures up to +300 °C 
complies to ISO 3384. 

This rig can be equipped with a liquid container,  
EB 02.01. 

It can also be equipped with an air tight container,  
EB 02.01P, together with a pressure gauge (EB 02.01P6) 
for measurements in liquid for pressure up to 3 Bar and 
temperatures up to +200 °C.

2.3.2 Rig for tension testing in high  
temperatures (+300 °C), EB 02TEHT
The EB 02TEHT rig for temperatures up to 300 °C 
complies to ISO 6914.

	 Note: This rig cannot be equipped with a liquid  
	 container.

2.3.3 Acid proof rig for compression  
testing in liquids, EB 02AP
The EB 02AP rig for temperatures up to 150 °C complies 
to ISO 3384 and is delivered by default with an acid 
proof air tight container. Default load cell will have 
600 N as force range (if not anything else is specified  
on the order).

2.3.4	 Super acid proof rig for  
compression testing in liquids, EB 02SA
The EB 02SA rig for temperatures up to 200 °C complies 
to ISO 3384. It is delivered by default with a container 
in super acid proof material and a compression plate. 
Default load cell will have 600 N as force range (if not 
anything else is specified on the order). 

2.3.5	 Rig for high force compression 
testing up to 45 kN, EB 02HF
The EB 02HF rig for temperatures up to 300 °C 
complies to ISO 3384.

	 Note: This rig is not included in this manual.

2.3.5	 Rig for compression testing with 
automatic liquid exchange, aeration 
and stirrer function, EB 02ALE
The EB 02ALE rig is for temperatures up to 200 °C.

	 Note: This rig is not included in this manual.

Rig for testing in liquids.
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3. Calibration
The rig temperature sensors and the load cells are at the 
delivery calibrated together with the data connection box 
according to the attached calibration certificate. The dial 
gauges are also included in the calibration certificate.

Calibration should be done annually.

4. Service and  
maintenance
The relaxation rigs shall be cleaned at regular intervals.

A service of the relaxation rigs should be done annually 
with lubrication of the screw and the rotating coupling.

5. Troubleshooting
If no data is coming to the computer, open the amplifier 
box and check that the LEDs on the data modules are 
showing green lights, if this is not the case, check the 
cable connections, see chapter 1.4.

If some module is showing a red light, something is 
wrong with that module.

If this does not help, check the fuses. The fuses are 
located in the power adaptor inlet, the value is 2 A 
(slow).

Before changing a defective fuse, check for any possible 
short circuit, causing the fuse to burn.

6. Safety
	 Note: Use gloves when lifting the rig from a  
	 cell oven, as the rig may be hot.

	 Important! For the best performance of the  
	 instrument, we recommend the following working  
	 environment:

	 •	Standard laboratory temperature of either  
		  23 °C ± 2° or 27 °C ± 2 °.

	 •	Humidity not more than 90 % RH    
		  – non condensing.

	 •	For long term logging instruments secure the  
		  power to the computer with a double converting  
		  UPS, for reducing electrical disturbances and  
		  power failure. (Ask Elastocon for recommendations  
		  or quotation.)

	 •	Other environmental aspects: Pollution degree 2  
		  – Laboratory environment.
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The EB 02 is a rig for continuous stress relaxation measurements in both compression and tension.  
The rig works together with the cell ovens EB 21, EB 22, the programmable temperature cell ovens EB 17  
and EB 21 LTHTP.

7. Technical specification

Stress Relaxation Rig	 EB 02	 EB 02HT	 EB 02TE	 EB 02TEHT
Maximum temperature, °C: 	 +200	 +300	 +200	 +300
Default range in compression/tension, N: 	600	 600	 100	 100
Resolution, compression/tension, N:	 0,05	 0,05	 0,01	 0,01
Optional range in compression, N 	  
(must be specified in order):	 1 200/2 000	 1 200/2 000	 –	 –
Resolution, compression, N:	 0,1/0,2	 0,1/0,2	 –	 –
Accuracy, %:		  ± 0,1 of full range	 ± 0,1 of full range	 ± 0,1 of full range	 ± 0,1 of full range
Dimensions, dia × h, mm: 	 120 × 450	 120 × 450	 120 × 450	 120 × 450
Weight, kg: 		  4,5	 4,5	 4,5	 4,5
Material: 		  Stainless steel	 Stainless steel	 Stainless steel	 Stainless steel
Temperature sensor: 	 Pt 100, 1/3 DIN	 Pt 100, 1/3 DIN	 Pt 100, 1/3 DIN	 Pt 100, 1/3 DIN
Standards:		  ISO 3384	 ISO 3384	 ISO 6914	 ISO 6914

Suitable accessories	  	  	  	  
Liquid container:		 EB 02.01	 EB 02.01	 EB 02.12	 –
Air tight container:	 EB 02.01P	 EB 02.01P	 –	 –
Pressure gauge for air tight container: 	 EB 02.01P6 	 EB 02.01P6	 – 	 – 
Extension cords for load cell:	 EB 02.05.1	 EB 02.05.1	 EB 02.05.1	 EB 02.05.1
Extension cords for temperature:	 EB 02.05.2	 EB 02.05.2	 EB 02.05.2	 EB 02.05.2
Load cell 1 200 N: 	 EB 02.18 	 EB 02.18 	 – 	 –
Load cell 2 000 N: 	 EB 02.19 	 EB 02.19 	 – 	 –
Test piece holder: 	 EB 02.26 	 EB 02.26 	 EB 02.26 	 EB 02.26
Bending fixture with 3-point loading: 	 EB 02.29 	 EB 02.29 	 – 	 –

Stress Relaxation Rig	 EB 02AP	 EB 02SA	 EB 02ALE	 EB 02HF
Maximum temperature, °C: 	 +150	 +200	 +200	 +200
Default range in compression, N: 	 600	 600	 600	 45 000
Resolution, compression, N:	 0,05	 0,05	 0,05	 –
Optional range in compression, N 	  
(must be specified in order):	 1 200/2 000	 1 200/2 000	 1 200/2 000	 –
Resolution, compression, N:	 0,1/0,2	 0,1/0,2	 0,1/0,2	 –
Accuracy, %:		  ± 0,1 of full range	 ± 0,1 of full range	 ± 0,1 of full range	 ± 0,1 of full range
Dimensions, dia × h, mm: 	 120 × 450	 120 × 450	 120 × 450	 120 × 450
Weight, kg: 		  4,5	 4,5	 4,5	 4,5
Material: 		  EN 1.4404	 EN 1.4547	 Stainless steel	 Stainless steel	
		  (acid proof)	 (super acid proof)
Temperature sensor: 	 Pt 100, 1/3 DIN	 Pt 100, 1/3 DIN	 Pt 100, 1/3 DIN	 Pt 100, 1/3 DIN
Standards:		  ISO 3384	 ISO 3384	 –	 ISO 3384

Suitable accessories	  	  	  	  
Liquid container:		 –	 included	 included	 –
Air tight container:	 included	 –	 –	 –
Pressure gauge for air tight container: 	 EB 02.01P6 	 – 	 – 	 – 
Test piece holder:		 –	 –	 included	 –
Extension cords for load cell:	 EB 02.05.1	 EB 02.05.1	 EB 02.05.1	 EB 02.05.1
Extension cords for temperature:	 EB 02.05.2	 EB 02.05.2	 EB 02.05.2	 EB 02.05.2
Load cell 1 200 N: 	 EB 02.18 	 EB 02.18 	 EB 02.18 	 –
Load cell 2 000 N: 	 EB 02.19 	 EB 02.19 	 EB 02.19 	 –
				    NOTE! Must be connected  
				    to special control box,  
				    EB 02.24-x
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8. Accessories to the rigs
8.1 Container for compression testing  
of Stress Relaxation in liquids, EB 02.01

8.1.1 Use
This container can be used with the Stress Relaxation Rig  
EB 02 for compression. This makes it possible to test samples 
in liquids such as coolants, oil, water etc.

The container is not air tight. Maximum temperature is 200 °C.

8.1.2 Running a test
When testing in liquid the bottom compression plate should be 
removed from the rig by loosen the screw in the bottom of the 
rig. The upper compression platen should be replaced with the 
upper compression plate with a hole for the liquid to circulate 
through. Remember to remove the “whitish” isolation washer 
between the rod and the platen, the washer shall only be used 
when testing in air.

8.1.3 Technical data, EB 02.01
Maximum temperature, °C:	 +200  
Diameter, mm:	 90 
Height, mm 	 95 
Weight, kg 	 1 
Material: 	 Stainless steel

8.2 Container for tension testing of  
Stress Relaxation in liquids, EB 02.12

8.2.1 Use
This container can be used with the Stress Relaxation Rig, 
EB 02TE. This makes it possible to test samples in liquids such 
as coolants, oil, water etc.

The container is not air tight. Maximum temperature is 200 °C.

8.2.2 Technical data, EB 02.12
Maximum temperature, °C:	 +200  
Diameter, mm:	 90 
Height, mm 	 150 
Weight, kg 	 1,4 
Material: 	 Stainless steel
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8.3 Air tight container for compression 
testing of Stress Relaxation in liquids, 
EB 02.01P

8.3.1 Use
This air tight container can be used up to a pressure of 
3 Bar together with the Stress Relaxation Rig, EB 02. 
This makes it possible to test samples in coolants under 
pressure.

When testing in volatile fuels evaporation can be elimi-
nated, which reduces explosion and environmental risks.

The container is equipped with a safety valve set to 
about 3 Bar.

Maximum temperature 150 °C.

8.3.2 Running a test
Keep the O-ring for the central rod lubricated with 
silicone oil to reduce the influence on the force reading 
from the O-ring.

When testing under over-pressure, the pressure in the 
container will influence the force on the load cell. How 
much it will influence is depending of the size of the test 
piece and the free surfaces on the top and bottom of the 
upper compression platen. Even if the absolute force can 
be different the change in force is correct.

When testing in liquid the bottom compression plate 
should be removed from the rig by loosen the screw 
in the bottom of the rig. The upper compression 
platen should be replaced with the upper compression 
plate with a hole for the liquid to circulate through. 
Remember to remove the “whitish” isolation washer 
between the rod and the platen, the washer shall only be 
used when testing in air.

8.3.3 How to replace the O-ring seals
1.	 Remove the lids from the relaxation rig according  
	 to the drawing in this manual.

2.	 Remove the old O-rings.

3.	 Mount the new O-rings. To make it easier to  
	 mount the lid in the rig lubricate the O-rings  
	 with silicone oil.

8.3.4 Technical data
Temperature range, °C: 	 +5 to 150  
Diameter, mm	 90 
Height, mm 	 95 + 25 
Weight, kg 	 1.1 
Material: 	 Stainless steel 
Seals: 	 Fluoru rubber or EPDM

Consumables 
EB 02.01P1	 Set of 6 O-rings, FPM for EB 02.01P 
EB 02.01P2	 Set of 6 O-rings, EPDM Peroxide cured  
	 for EB 02.01P

Optional pressure gauge, EB 02.01P6
Together with a pressure gauge (EB 02.01P6) the 
air tight container, EB 02.01P, can be used for 
measurements in liquid for pressure up to 3 Bar and 
temperatures up to +200 °C.
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8.4 Fixture for bending test, EB 02.29

8.4.1 Use
With this fixture it is possible to measure the force change 
over time with a 3-point loading. The test fixture is 
developed from ISO 899-2 but the actual test is a type of 
stress relaxation test for plastic material.

The deformation is calculated with help from the standard, 
the chosen deformation in percentage could be up to 10 %, 
if it is to much the material may break. During the actual 
test is the force decrease measured automatically and 
continuously. 

If the big decrease of the force that occurs in the beginning 
of the test should be displayed, please set F0 to 1 minute 
instead of the default 30 minutes in the software. The 
reason for recommending 1 minute instead of 0 is that the 
maximum force is dependent of the speed of deformation of 
the sample. If 1 minute is used as general value, the results 
will be more comparable between different tests. 

Be observant of the force needed, and if necessary order an 
additional load cell to ensure the best accuracy.  

For further instructions, please read standard ISO 899-2 and 
the rest of this manual in how to perform a test. 
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9. Relaxation Software EC 05

This manual is applicable on the EC 05 Relaxation 
software version 2.0 or newer and Relaxation Viewer 
version 2.0 or newer.

Important computer settings
The following settings must be set to guarantee a stable 
function of the EC 05 Relaxation software.

When the system is shipped, the computer will already 
have appropriate settings applied, but if Windows is 
updated or reinstalled, these settings may be affected. If 
so, the following settings must be reviewed and applied 
to ensure a stable function of the Relaxation application. 
The name, availability, location of and configuration for 
these settings may vary with Windows versions. 

	 1.	 Never turn off hard drives. 
	 2.	 Never put the computer to sleep. 

	 3.	 Inactivate hibernation usage. 

	 4.	 Do not allow hybrid sleep. 

	 5.	 Do not enable wake up on LAN. 

	 6.	 Never allow suspension of a USB port. 

	 7.	 Do not let Windows automatically restart  
		  the PC after updates are installed.

	 8.	 Disable automatic update for the operating system.  
		  Download of updates are allowed, but no  
		  automatic installations. The reason for this is that  
		  the system may re-boot the computer after  
		  installing updates when the EC 05 Relaxation  
		  application is running.

	 9.	 Disable Windows Fast Startup.

 	 10.	Disable automatic scanning of EC 05 Relaxation  
	 	 test files by any anti-virus software.

	 11.	If using a firewall – permanently allow the IP  
		  number of the data box to act as client and server.

Backup Considerations 
It is highly recommended that the test files folder be 
backed up regularly since it contains your valuable data. 
The test files are normally stored at C:\Elastocon data.

9.1 Start application
Double click on the icon for  
relaxation to launch the application.

9.2 Configuration view
The application will start up in the configuration view. 
A hardware configuration profile that matches the 
delivered hardware is supplied by the manufacturer. 
This profile was added with the software installation and 
will now be loaded every time the relaxation application 
is launched.

The hardware profile can be managed by using a 
separate configuration tool (HW ConfigUtility). See 
separate manual for this software.

The configuration view enables the user to pick 
items from the hardware profile and configure a 
user configuration for a test setup. Changes in the 
configuration view should only be made while no 
measurement is running as it may affect ongoing 
measurements. The configuration window is split into 
a hardware field (upper) and user configuration field 
(lower).
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9.2.1 Hardware Configuration 
The upper field in the configuration view shows a list of 
all hardware added by the manufacturer.

The structure of this list cannot be modified. 
Modifications can only be made by the supplier of this 
system.

The user can change hardware address, re-connect 
hardware and view sensor properties.

The hardware setup is as a tree structure with rigs as top 
level items with one or more included sensors.

A click on the +/– glyphs to the left will show or hide 
sensors for the rig.

The entire tree structure can be shown as a collapsed 
or expanded view. Right-click on the header of the 
Hardware Configuration column, to access this feature. 

Rig items
Rig items in the example picture are Rig 1 and Rig 2 and 
are shown as an expanded view.

Right click on any rig items in the list. A drop list menu 
will show all commands available.

Available commands are:

Change address. – will change rig address so it 
corresponds with the hardware listed. All underlying 
sensors for this rig will be re-directed to the new 
address. See chapter 9.2.4.

Connect – will re-establish connection with hard
ware that was disconnected or turned off at the time the 
application was started or had a log running.  
See chapter 9.2.4.

Rig sensors
Right-click on any of the underlying rig sensors, 
Temperature… or Force…

A drop list menu will show all commands available.

Available commands are:

Sensor properties – will view the sensor properties for a 
sensor. Properties are offset, gain, sensor name, physical 
quantity and unit adjustment table.

A new sensor can also be imported here as an alternative 
sensor for an existing sensor. This is useful when the 
same hardware input uses more than one different 
physical sensors or if a sensor breaks and requires a 
replacement sensor. See chapter 9.2.3.

Change address – Change sensor address so it matches 
the connected hardware. ONLY THIS SENSOR will be 
re-directed to the new address and no other sensors. 
See chapter 9.2.4.

Application features regarding sensors:
•	 The application will try and establish connection with  
	 all sensors in the Hardware configuration list at  
	 application launch.

•	 The application will automatically disconnect sensors  
	 that have been switched off or lost communication  
	 with the application. Conditions for a disconnection  
	 are setup in a system file. The conditions for this can  
	 be modified, but this is not described here. Contact  
	 the supplier of this system to change these conditions  
	 if necessary.

	 To restore a disconnection status, the user must at  
	 that point manually re-connect the instrument.  
	 See chapter 9.2.4.

•	 Failure in communication will change the sensor  
	 status to Disconnected for any sensor that fails to  
	 connect.

	 Sensors with the Disconnected status will still be  
	 available in the list, but this sensor will not be scanned  
	 for readings.

	 The connection can be re-established at any time,  
	 even with a log running, as long as the hardware is  
	 connected properly.

	 To resolve the disconnected status, go to chapter  
	 9.2.5. 
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9.2.2 User Configuration
The lower field in the configuration view shows a list 
of rigs with sensors, copied from the upper field and 
bundled into groups, as the user specified.

This field will remain blank if no user configuration was 
loaded at program launch.

Use a prepared file
The application will automatically open the currently 
used user configuration file at application launch and the 
application is ready to start a test. Go to chapter 3. Log 
view, to prepare a test for logging.

It is also possible to load a stored user configuration file 
or create a new group setup.

Load a stored user configuration
1.	Go to the File menu and select Open.

2.	Choose a file and click on the OK.

3.	Go to the File menu and select Load to log.

4.	Go to chapter 9.3. Log view, to prepare a test  
	 for logging.

Create a new group set-up
1.	Go to the File menu and select New. The user  
	 configuration field will be initiated with a blank  
	 white field.

2.	Right-click on the blank white field in the User  
	 Configuration column and select New Group.

3.	Enter a suitable name for the group. e.g. ”Group 1”  
	 or a name that refers to the type of test,  
	 location etc. Group 1 is set as default.

	 The idea with the group set-up is to bundle rigs  
	 that must be stored in the same log file. Rigs in the  
	 same group will all be managed and started  
	 at the same time when logging.

4.	Highlight hardware from the Hardware  
	 Configuration list with a click on the rigs.

	 More than one rig can be highlighted at the  
	 same time. Use Shift+click to select a range  
	 or CTRL+click to add any rig to the selection.

	 Drag and drop the selected hardware on  
	 to the group name that was created in the  
	 User Configuration field.

5.	Go to the File menu and select Save or Save As.  
	 Type in a suitable file name for the configuration  
	 made. MyConfig.tvc is set as default.

6.	Go to the File menu and select Load to log. The  
	 user configuration will now be loaded to the log  
	 view and ready to be used for test.

	 Continue with chapter 9.3. Log view to prepare  
	 a test for logging.

IMPORTANT!
•	 The configuration made and saved must remain  
	 the same as long as the same log is recording in the  
	 Log view. Any test interrupted by the user, power  
	 failure etc. cannot be resumed, if the configuration  
	 is lost or has been changed.

	 It is recommended not making any change to the  
	 User Configuration file once it has been used for  
	 logging.

•	 It is not possible to make any changes to a User  
	 Configuration file when it is loaded to Log. If changes  
	 are necessary, the user must first open or create a new  
	 User Configuration file, load this to log and after that  
	 open the file that needs to be changed. The file opened  
	 now can be changed.

•	 A rig copied to a group from the Hardware  
	 Configuration field cannot be copied to another  
	 group.

•	 Once the bundled group(s) has been saved to file, this  
	 file can be re-used for other tests.

•	 A hint is to give the file a suitable name of its content.  
	 When the user configuration has been saved and  
	 loaded to Log view with Load to Log, it can be used  
	 for logging.

•	 A maximum of three rigs can be loaded to a report  
	 using the Table & Graph report setup. Statistic  
	 calculations will be done when more than one rig is in  
	 the report. See chapter 9.4.31 for more details.  
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9.2.3 Sensor properties
Right-click on the sensor in the upper field and select 
Sensor properties.

This window allows the user to view sensor properties 
and import a new sensor. It can be useful if a sensor 
must be replaced for any reason.

The new sensor from the manufacturer is normally 
delivered with a new sensor property file (*.tvs file). By 
importing the new profile on top of the existing sensor, 
it is possible to continue the logging without losing 
valuable test time.
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Import a new sensor
To import a sensor, make sure no measurements are 
running, since a sensor cannot be imported when a log 
is running. If measurements are running and you need 
to import a sensor, simply close the application without 
stopping the measurements, by opening the file menu 
and clicking Exit or by pressing CTRL+Q. DO NOT stop 
the running measurements unless the test is finished. 
Stopping a log is definite and the log cannot be restored 
to be in an unstopped state. 

After import of a sensor, go to chapter 9.3.4.3, to resume 
the ongoing measurements.

Import of a sensor will create an alternative sensor.

	 1.	 In the Hardware Configuration view, right-click 
	 	 on the sensor in the upper field and select  
		  Sensor properties.

	 2.	 In the sensor properties  
		  windows, click Import  
		  from file..

	 3.	Browse to the folder where the new sensor file is  
		  located and select it and click OK.

	 4.	Click OK.

		  A new sensor will appear in the Sensor Name  
		  list box.

	 	 The new sensor can be identified by a matching  
		  serial number on the sensor and application  
		  sensor name.

		  After import, the new sensor will be set as  
		  default for this input and is ready to be used.

Remove a sensor
It is not possible to remove a sensor item with its 
properties in the Relaxation application because it is 
involved with a risk to remove a sensor by accident.

Removing a sensor can only be done in the  
HW ConfigUtillity application. See separate  
manual for the HW ConfigUtillity application.

Removing a sensor with its properties can be useful 
when information for a broken or replaced sensor is no 
longer needed.
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9.2.4 Change address
Sometimes the rig address must be changed due to 
address conflicts, especially when the rig data box is 
connected to a computer network (LAN).

The address must first be changed in the instrument 
EB 02.14-X, the amplifier box. Instructions on how to 
do this can be found in chapter 1.4. As a second step, 
the new instrument address must then be set in the 
application.

In the Hardware Configuration view, right-click on  
the desired rig item and select Change Address to open 
the Change Address window. Enter the new rig address 
and click OK.

9.2.5 Connect (Re-connect a rig)
If the rig data acquisition box gets powered down 
or loses network connection, the application will 
disconnect the rigs from this data box or device.

To re-establish connection, the user must initiate the 
connect sequence for each rig. This can be done in the 
Configuration view (upper field).

First, make sure the data acquisition box is powered and 
the data communication is working.

Protocols supported by the EC 05 Relaxation are:
TCP/IP-/WAGO/Vision350 – Make sure the data cable 
is plugged in correctly. If the data box/PLC is connected 
to a LAN, make sure the LAN is not blocking the IP 
number for this data box/PLC.

RS232-/SERAD/Mitutoyo/Shinko – Make sure the data 
cable is plugged in correctly.

If the data acquisition box/device uses this RS232 
interface protocol, make sure the RS232 port is not 
used by another service, device or application on the 
computer with the EC 05 Relaxation application.

If the data box/device uses ethernet, the IP-address on 
the PC must be on the same subnet as the data box (i.e. 
differing only on the last group in the IP-address, e.g. 
192.168.10.xx). If the PC is connected directly to the data 
box, the IP-address of the network card in the PC shall 
have a fixed IP-address set.

If the IP-address is ever changed on the Wago data box, 
be sure to mark up the data box with the new IP-address 
on the box itself, since the Wago configuration software 
using Ethernet will only work when the exact IP-address 
is known.

In the Configuration view, right-click on any rig item in 
the Hardware Configuration field and select Connect. 
The application will search for hardware changes on the 
selected rig. If the rig data acquisition box is powered 
and has communication, it will respond by changing the 
status to Connected.
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9.3 Log View

Change to the log view by clicking on Log in the upper 
left corner of the Relaxation application window.

The Log view is where you will configure and monitor 
the measurement logging.

When the application is launched, the previous user 
configuration will be loaded and is ready to be used, but 
if a user configuration has not been created it needs to 
be created (see chapter 9.2.2).

Before starting a test, the group or groups that you want 
to perform a measurement on needs to be set up for the 
measurement (see chapter 9.3.2).

9.3.1 Adjusting zero
The force sensors are possible to tare. The tare function 
will set the sensor to zero.

Apply the zero function
	 1.	Right-click on  
		  each rig and 
		  choose Open.

	 2.	 If the sensor is a  
		  load cell, make  
		  sure that the  
		  sensor is physically unloaded.

	 3.	 In the Station View, click Zero under the indicator  
		  for Force (N). The value should switch to 0,0.

		  If a digital position indicator is attached to the  
	 	 user configuration, the Zero button for this will be  
		  enabled. It is now possible to adjust the zero  
		  position.

	 4.	Click on the OK button to apply the changes.
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9.3.2 Setup
Each group and the group’s included rigs need to be set 
up before a measurement can be started.

Setup Group
Right-click on the Group and select Setup... A window 
for the Group Setup will appear.

Group setup window displaying recommended logging intervals 
and sample interval.

Group setup

	 1.	Enter an Operator name.

	 2.	Enter a File Identifier. The file identifier will be  
	 	 used as file name for the result file.

		  The application will automatically add the log start  
	 	 date and time to the given file name at log start.

	 3.	Optionally enter comments in the Comment  
	 	 field.
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	 4.	Specify Logging interval(s)

		  a.	 Enter a sample interval. The recommended  
			   value is 30 seconds. This value will set the base  
			   frequency on how often the logger can record  
			   the data.

		  b.	 In the Logging intervals table, type in the  
	 	 	 first value in minutes.

			   This is the time from log start.

		  c.	 In the next column Log every n:th sample,  
			   type in how frequently the log should record  
			   data based on the Sample Interval.

			   That is, with a value of 1, from start and  
			   60 minutes ahead, the logger will record data  
			   every Log interval (30 seconds)

		  d.	 Continue to add rows with Minutes and  
			   Log every n:th sample.

		  e.	 The last row in this table must be set as  
	 	 	 Inf (infinite).

	 The example table is the recommended settings and 	
	 will:

	 •	 Record data every 30 seconds from log start and  
		  60 minutes ahead.

	 •	 After 60 minutes record data every minute  
		  (Log every n:th sample 2 x Sample interval 30   
		  = 60 seconds/60 = 1 minute for the next 24 hours  
		  (1440 minutes)).

	 •	 After 24 hours record data every 30 minutes  
		  (Log every n:th sample 60 x Sample interval 30  
		  = 1800 seconds/60 = 30 minutes).  
		  The logger will record with this last interval for as  
		  long as the log is running.

		  Important!
		  Setting up the table correctly will allow for more  
		  frequent log points when it is needed.

		  The beginning of a test is where the test changes  
	 	 the most. With this setup the user will keep the file  
		  at a reasonable size. Logging very often on many  
		  rigs for a long time can produce very large  
	 	 files which also will take longer to process during  
		  calculations.
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	 5.	Enter a stop time in hours and minutes. When the  
		  stop condition is met during the test time, a dialog  
		  will pop up with information that this time has  
		  been reached. However, the log will continue to  
		  record data until the user stops the test. The value  
		  00:00 in this input box will disable the stop  
		  function.

	 	 If a stop time is specified, the user will be notified  
		  when the stop time is reached.

	 6.	Type in an F/F0 tolerance (%). The value is  
	 	 specified as change from F0. E.g. a value of 10  
		  means a change of 10 % since F0.

		  If the value is set to 50, a dialog will pop-up  
		  with information that the F/F0 is reduced by  
		  50 %, when F/F0 is equal or higher than 50 %.

		  Set to 100 will trigger the dialog when the F/F0  
		  is reduced by 100 % (No counter force left in the  
		  material). It is recommended to set this value  
		  to 50.

	 7.	Tick the box Strain Compensation to use a  
		  calculated force compensation for the load cell  
	 	 deflection.

Setup Rigs
	 1.	Right-click on the first rig in a group and choose  
		  Setup…

		  The Station Setup window will appear for the  
		  selected rig
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	 2.	Select Test Type tension or compression.

	 3.	 Enter the sample dimension.

		  a. The measured thickness in mm before  
		     the mechanical conditioning.

		  b. Sample diameter (mm) is information and  
		     is not used.

	 4.	 Enter the % compression needed for the test.

	 5.	 Compression (mm). The value calculated by the  
		  application is information about how much the  
		  sample should be compressed.

	 6.	 Force Sensor, please double check that the correct  
		  load cell is chosen.

	 7.	 Enter a grade name, e.g. material name/number,  
		  batch number etc. This information will be visible  
		  on the report.

	 8.	 Optionally, add a comment in the Comment field.

	 10. Go back to point 2 and repeat 2 to 7 for every rig  
		    in the group. 

9.3.3 Evaluation points
The table for evaluation points can be found in the upper 
left field of the Log view.

Each group has its own list of evaluation points. To view 
evaluation points for a group, select the group in the 
drop-down list above the evaluation point table, or select 
the group in the tree view to the right of the evaluation 
points table.

The table’s calculated values R(t) and F/F0 will be 
updated with values in real-time as the log continues to 
record.

The table is be stored in the test file together with 
the group and will be read in the Relaxation Viewer  
application.

Recorded points for this table are the relaxation in 
percent (R(t)) and F/F0. These evaluation points are 
median values from all rigs in this group.

The evaluation point times will be used as default values 
for that group the next time the application is started, if 
the group has started. 

It is possible to add, modify and remove evaluation 
points after the test has started. Whenever a change is 
made to this table, the evaluation point values will be 
recalculated. To delete a point, select the time field data 
and press Delete. Add points by writing a time-value 
(HH:MM) in a new row in the Time column. To only 
specify hours, the format HH:: is also possible. 
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9.3.4 Start

Conditioning prior to test start
According to the ISO test standard the samples shall 
be conditioned before the test. This is described in the 
standards. A summary of this text for ISO 6914 test 
in tension should be to condition the samples for a 
minimum of 3 hours at standard laboratory temperature 
before testing, kept out of light and without contact with 
other test materials with different compositions.

A summary of the conditioning text for ISO 3384 test 
in compression is that the test pieces should undergo 
both a thermal and mechanical conditioning prior to 
test start. The thermal conditioning consists of heating 
the test pieces to 70 °C for 3 hours with possibility to 
rest not less than 16 hours and not more than 48 hours 
at standard laboratory temperature prior to mechanical 
conditioning.

Remember to measure the thickness of the samples 
before the mechanical conditioning.

The mechanical conditioning shall be at standard 
laboratory temperature and consists of compressing  
the test pieces to the same compression that will be 
used during the test (often 25 %) immediately release 
them to zero stress, this repeated for a total of 5 cycles of 
deformation and immediately return. Let the test pieces 
rest at standard laboratory temperature no less than  
16 hours and no more than 48 hours prior to test start.

The mechanical conditioning improves the test 
reproducibility, especially for compounds with a 
considerable amount of filler, it is not always suitable  
for finished products.

When testing according to other standards, check the 
valid standard for the correct procedure.

Test start
You will find a simplified step by step instruction, named 
as User Guide, in the last pages of this manual.

	 1.	Place the rigs in the oven to preheat them.  
		  This minimizes the temperature drop when  
		  inserting the rig with the sample mounted and  
		  will shorten the time needed to stabilize the  
		  temperature before test start.

		  Note: When working with the rigs here after  
		  they might be hot so use protection gloves.

	 2.	Zero the rigs.

		  a.	 Choose a rig in the Log view, right click on it  
			   and choose Open. Look at the window that  
			   opens and make sure that you have the correct  
			   rig opened. Also note that some station  
			   information is available in the lower left of the  
			   station window.

		  b.	 For compression: Check that the dial gauge  
			   is zero when the platens are together (with  
			   approximately 10 N force applied) and zero  
			   the position. Then raise the upper platen a  
			   couple of mm and go back down 0,5–1 mm  
			   approximately, then you zero the force.  
			   Make sure that the platens are NOT closed  
			   when you zero the force. 
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		  c.	 For tension: Set the free distance between  
			   the clamps to 50 mm, make sure you turn the 
	 	 	 clamp first up and are in a down motion when 
			   you reach the 50 mm, use a 50 mm gauge block  
			   to set the distance, zero the position and the  
			   force.

	 3.	Mounting the samples

		  a.	 For compression, lubricate the sample contact  
			   surface on the upper and lower compression  
			   platens with suitable lubricant according to  
			   ISO 3384, alternatively lubricate the sample  
			   itself. Load the test pieces in centre of the  
			   platens in the rig, add a small pre-load of  
			   approximately 10 N to make sure it stays in  
			   place. Put the rig back into the cell oven again  
			   to stabilize the temperature.

		  b.	 For tension, we recommend a test piece that  
			   is 22 mm longer than the test length entered  
			   in the test set-up, which is total test piece  
			   length of 72 mm for a 50 mm free distance  
			   length as above.

			   Turn the rig clockwise until the distance  
			   between the tension clamps is about 49 mm.  
			   One full turn on the screw corresponds to  
			   1 mm of displacement.

			   The reason why it is recommended to reduce  
			   the distance with 1 mm is that a 1 mm thick  
			   test piece will expand a bit when it’s clamped. 

			   In tension, change F0 to 5 min.

			   Mount the test piece in the clamps. Insert 		
			   the test strip in both clamps until the test piece  
			   reached the bottom of the clamps. That is  
			   11 mm in each end of the test piece should be  
			   inserted in each clamp.

			   When the test piece is clamped, turn the rig  
			   screw one turn anti-clockwise to go back to  
			   the 50 mm free distance between the clamps.

			   Put the rig inside the cell oven again to allow  
			   the temperature to stabilize.

	 4.	Starting the test

		  a.	 To start the test in compression:

			   i.	 Right click on the group and select Start.

			   ii.	 Right click on the rig and open the window   
				    again by choosing Open. In this station 
	 	 	 	 view window you find information about	
				    the compression and the total compressed 
				    thickness.

				    These values are good to have when  
				    compressing the sample, you can see on  
				    the gauge on the rig that you compressed  
				    until the right value (for info about the  
				    gauge, please look at chapter 2.1.4).  
				    Compress your sample according to your  
				    standard.
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		  b.	 To start the test in tension:

			   i.	 Right click on the group and select Start.

			   ii.	 Right click on the rig and open the window   
				    again by choosing Open. In this station view 
	 	 	 	 window you find information about the 
				    tension in mm.

				    You elongate the test piece by turning the  
				    rig screw anti-clockwise until the distance  
				    between the tension clamps has stretched  
				    out the test piece to the given elongation  
				    in the window for each rig.

				    One full turn on the screw corresponds to  
				    1 mm of displacement.

The test is now running and recorded data points will be 
plotted on the graph. The graphs setting can be changed 
and the size can be adjusted by dragging the split bar 
between configuration and graph windows.

Change graph settings
To change plot colour, left-click the coloured cell for the 
sensor in the Plot column to show the colour selector. 
To change the line width, right-click the coloured cell for 
the sensor in the Plot column to show the line properties 
menu.

Right-click in the graph, to access all visual settings for 
the X and Y-axis.
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9.3.4.1 Calculate F/F0
The t0 and the t(F0) must be set before the application  
can automatically calculate F/F0 (relative force).

	 1.	Click on a rig item

	 2.	Untick the Relative Time tick box to set the graph  
		  time to absolute time.

		  	

	 3.	Tick t0 cursor to enable the t0 cursor for this rig.  
		  The t0 is the time for the maximum compression  
		  or tension force reached at start. The value can  
		  be set either by entering a time in the t0 indicator  
		  or by dragging and releasing the black t0 cursor to  
		  the wanted time.

		  Make sure to set the t0 cursor to the point of  
		  the maximum force at start.

		  The black t0 cursor is found on the y-axis to  
		  the left in the graph.

		  Make sure to highlight the corresponding rig  
		  and not any other rig or group.
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	 4.	T(F0) is the time for the initial force and is  
		 according to standard. 30 minutes is set as  
		 default, which correlates to compression test.  
		 For tension test, change this time to 5 min. 

	 5.	Tick the box F/F0 in the graph to show the  
			  relaxation curves as F/F0. The relative force F/F0  
			  will now be calculated automatically and shown  
			  in the graph.

9.3.4.2 Add an extra log point
When the log is running, it is possible to add an extra log 
point at any time.

The extra log point can be useful when the user wants to 
take control of an extra precise log point at time critical 
situation.

An example of this could be to record a special treatment 
during the test at a specific time.

The user can choose to add extra log point as just an 
extra log point or as an evaluation point. An evaluation 
point will be shown on the report printout.

Add an extra log point
	 1.	When the log is running, click Sample (main menu  
		  button). 

	 2.	Choose one group to add the extra log point to.

	 3.	Tick the box Evaluation Point, if the extra log  
		  point shall be added as an evaluation point. 

	 4.	Click OK
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9.3.4.3 Re-start after log interruption (power 
failure etc.)
If the software has been re-started after a power failure 
or system re-boot, the application will wait for the user 
to act, before the log can be resumed.

	 Note: If the user decided to stop an ongoing log,  
	 it cannot be resumed. The stop log command will  
	 stop the ongoing logger with test file permanently.

After such an interruption the application will connect to 
all listed instruments but will not continue to log.

A shortcut to the application can be placed in the 
Windows start-up folder for selected users or all users.

Re-start a log
	 1.	Double click on the icon for relaxation to launch  
		  the application. The application will start up in the  
	 	 configuration view.

	 2.	Go to the Log view and right-click on any group  
		  that needs to be re-started and select Setup...

	 3.	Click on Advanced.

	 4.	 In the advanced group settings, click Search.

	 5.	Highlight the file to resume and click OK.

		  A green light indicator File OK to continue on will  
	 	 display to indicate if the file can be resumed.

	 6. Check the group settings in the group setup  
		  window and click OK. 

		  Right-click on the group and select Start.

9.3.4.4 Stop logging
To stop logging of a group, select the group and click 
on Stop, or right click on the group and select Stop. 
Stopping a log is definite and the log cannot be restored 
to be in an unstopped state, so only stop the test once 
you are certain that the measurement is finished.

If the logging has been stopped due to an end condition 
(F/F0 or stop time), the force value presented in the tree 
view will have red background and will stop updating 
until a new measurement has been started on a group 
again.
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9.4. Log File Viewer
The log file viewer is installed as a separate 
application. Double-click the Relaxation 
Viewer shortcut on the desktop to run the 
application. 

The Relaxation Viewer is used to view, analyse, print and 
export log data from both ongoing and finished log files. 
When a log file is opened, the current data in it will be 
presented. 

9.4.1 Getting help
A brief tip will be displayed for things you hover over 
in the application. To display the context help window, 
which will display more information, press CTRL+H or 
go to the Help menu and click on Show Context help. 
This window will display more information on things 
you hover over in the application. To close the context 
help window, click on the X in the upper right corner of 
the window.

9.4.2 Access log files 

By default, the log files are stored on the local computer 
at C:\Elastocon data\Relaxation data. These files must 
be backed up regularly in case of e.g. a drive failure or 
accidental deletion. A suggested way of backing up is 
to copy it to a network storage, from where users only 
wanting to view the log data can access and open the 
files.

Another possibility to reach the files from another PC 
would be to make the test result data folder shared. 
However, this is not recommended since there is a 
risk that currently logging files are interfered with 
(accidental deletion, locking of files etc.).

If the log files are copied manually from the result file 
folder to e.g. a USB, make sure you copy them and do 
not move or cut the selection of files.

9.4.3 View log file data
To open a file, click Open, or press CTRL+O or open the 
File menu and select Open. The default log file folder 
will be pre-selected in the open-file dialog. Select one or 
more files to open and click OK. The file(s) will open and 
display its properties in the upper part of the application 
window, the tree view, and display the data in the graph 
in the lower part of the window. The application looks 
much like the log view in the Relaxation application but 
has some differences.

Actively logging files will not update data in the viewer 
application on already opened files. Just close and open 
the file again to update the data.

To close a file, select the file, or any item within a file, 
and click Close or press CTRL+W, or open the File menu 
and click Close. Multiple files can be selected and closed 
at once. If only one file is opened that file will be closed 
regardless of what is selected when closing.

9.4.5 Compare log file data
Open more files. Every opened file will be displayed in 
the graph. Force plots will be coloured differently for 
each opened file. Temperature plots will all be opened 
with different shades of red.

Close files you are not interested or choose not to display 
them by clicking on the tick to the left of the file name in 
the tree.
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9.4.6 Select visible plots
When multiple files are opened, choose not to view 
anything but the plots you want to compare, to make 
it easier to read the graph. Do this by clicking the tick 
to the left of anything in the tree that is not of interest. 
Items (files, groups, stations, sensors/plots) that are 
not ticked will not be displayed in the graph. When the 
selection is changed, the graph will autoscale once to 
adapt to the visible data.

9.4.7 View information
The tree header displays information for the selected 
item in the tree. 

	 –	 If a file or group is selected, t0 and t(F0) are  
		  available and will display values if all stations in  
		  that group have the same value. If values are  
	 	 different, NaN will be displayed.

	 –	 If a station (rig) is selected, t0 and t(F0) for that  
		  station is displayed, and its cursor values.

	 –	 If a sensor is selected, its cursor values will be  
		  displayed and the containing station’s t0 and 
t(F0).

The tree displays information about the measurement 
file, group, station (rig) and sensor.

	 –	 The Target column displays the target  
	 	 temperature as specified in the station settings.

	 –	 The Unit column displays the unit for the sensor.

	 –	 The End time column displays the last  
	 	 measurement time for the test. If this field is  
		  empty for a group, it means the measurement is  
	 	 not finished.

	 –	 The End Condition column displays the condition  
		  to when the measurement shall stop, if there is a  
	 	 condition set. And end condition can be a specified  
		  stop time or F/F0 level, or both.

	 –	 The following columns Operator, Grade name,  
		  Test type and Comment displays the information  
	 	 as specified in the group settings for the group.

9.4.8 View cursors
There are three different cursors that can be activated. 
Tick the box for the cursor that shall be visible. The 
value of the cursor is displayed next to the cursor tick 
box. The unit of the values are the same as the unit of 
the corresponding graph axis.

t0 displays the location of t0 for the item selected in 
the tree. The cursor can be moved by dragging it to 
the desired location (see section Change t0). If the 
selected item is a group or file, the value will only 
be displayed if t0 is the same for all stations in that 
group.

t(F0) displays the location of t(F0). The location of 
t(F0) is determined by t0 and t(F0). To change t(F0), 
see section Change t(F0).

Free cursor displays the value of the currently 
selected sensor (Force, Temperature). The cursor 
can be moved by dragging it. When another sensor 
is selected, the cursor will move to the nearest log 
point. The value will have the same unit as the graph 
displays. E.g., if a force plot is selected and F/F0 
is active, the F/F0 value is displayed in the cursor 
indicator. The time value is also in the same unit as 
the graph time scale.

9.4.9 Move cursors
To move cursors, the cursor tool needs to be active. It is 
active by default, but if you have used a zoom tool, you 
need to activate the cursor tool again by clicking  
on it in the graph tools below the graph.

Cursor tool

9.4.10 Set graph time mode
The graph time will by default be set to relative time.  
t0 is then time=0 on the graph.  
Untick Relative time to switch  
to absolute time mode.  

When switching between relative and absolute time, 
the x-scale will autoscale once, since it is not known for 
which t0 to relate to when switching.
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9.4.11 View log data details
The details of a log point can be examined. Right-click 
a station and select View log point. To view a specific 
log point, either enter a time or click the left or right 
arrow to step through log points. If a time is selected, the 
nearest log point will be displayed, and the time will be 
adjusted to the time for that log point.

To quickly scroll through log points, select either the 
seconds part of Time (e.g. by clicking on the seconds 
part) or select all figures in Time (e.g. by double-clicking 
on the time data) and scroll using the mouse wheel, 
which will step through log points.

9.4.12 Find Relaxation 

The time for a specified level of relaxation can be found 
using the log point viewer. Open it by right-clicking 
a station and select View log point. Enter the desired 
relaxation level and press enter to display the calculated 
relaxation time and the nearest log point details.

9.4.13 Lifetime estimation
Use the log point viewer to find relaxation (see section 
Find Relaxation) to search for the desired levels of 
relaxation and use those values and the corresponding 
time to plot an Arrhenius plot. Elastocon provides a 
separate application, Arrhenius Plot, for plotting and 
evaluating Arrhenius plots.

9.4.14 Change t0
When opening a file, t0 is automatically calculated (new 
feature in Viewer 2.0). But it is possible to manually 
change t0.

To change t0 for all stations in a group, click on a group 
or file to select it and change the time in the t0 indicator. 
The time must be in the same format as displayed in the 
indicator, so the easiest way to get that right is to only 
select and change the part you need to change. Press 
Enter to apply the change or click outside of the time 
control.

To change t0 for one station, select that station in the 
tree and change the time in the same way as for a group, 
or enable the t0 cursor by ticking the box t0 above the 
tree and drag the t0 cursor in the graph to the desired 
location.

The effect of the changed t0 will be visible as soon 
as t0 is changed. The change will affect all displayed 
data using t0, such as the graph, report, export and 
evaluation points table. The updated t0 will not be saved 
to the log file.

9.4.15 Change t(F0) 

To change t(F0) for all stations in a group, click on 
a group to select it and change the time in the t(F0) 
control. Press Enter to apply the change or click outside 
of the t(F0) control. The updated t(F0) will not be saved 
to the log file.

To change t(F0) for one station, select that station in the 
tree and change the time in the same way as for a group. 
Press Enter to apply the change or click outside of the 
t(F0) control.

9.4.16 Edit information
Some group and station information can be edited. 
This can be convenient e.g. if the log file was run with 
incorrect information. The changed information will 
appear in the printed report. The updated information 
will not be saved to the log file. Right-click a group or 
station and click Settings to open the settings window 
for that item. Editable fields have white background. 
Non editable fields have grey background and will not 
accept data you enter. Click OK to accept the changes 
and close the settings window. The updated settings will 
immediately be displayed in the tree.
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9.4.17 Change plot colour
To change colour on a plot, click on the coloured field 
in the Colour column for a sensor/plot to bring up the 
colour selector menu. Click on a colour in the selector to 
set that colour for the plot you clicked on.

9.4.18 Change plot thickness and style 

To change thickness or style on a plot, right-click on the 
coloured field in the Colour column for a sensor/plot to 
bring up the plot style menu. Click on a setting to enable 
it.

9.4.19 Turn strain compensation off
Strain compensation is by default included in the 
displayed data, if the sensor that acquired the data 
supports it and strain compensation was active when 
logging was performed. Strain compensation is 
supported by all sensors that have a strain compensation 
value in the calibration data for the sensor, which 
has been the default for years when delivering rigs 
from Elastocon. Contact Elastocon if you have an old 
calibration and wish to compensate for strain. 

To display data without strain compensation, click the 
On value in the Strain comp. column for the group or 
station you want to turn off strain compensation for, and 
change to Off. The effects will immediately show in the 
graph. Strain compensation can sometimes have little 
impact so to see the difference you may need to zoom in 
when you toggle strain compensation. When stations in 
a group have different settings for strain compensation, 
the field for strain compensation for the group will 
display empty, but the selector for the group is still 
accessible and can be used to set all to on or off.

9.4.20 View calculated force values
Force can be displayed as F/F0, F/F(t0) or R(t) by 
ticking the respective box above the graph. 

F/F0 will display all force plot values divided by the force 
at F0. 

F/F(t0) will display all force plot values divided by the 
force at t0. When F/F(t0) is active, only the data between 
t0 and F0 will be displayed. 

R(t) will display all force plot values as relaxation values 
((1-(F/F0))*100). 

When F/F0 or F/F(t0) is enabled, Autoscale for the 
Y-axis will be turned off and the force scale will be set to 
be from 0 to 1. To see values above 1, just tick Autoscale 
Y-axis to autoscale and see the data.

When R(t) is enabled, Autoscale for the Y-axis will be 
turned off and the force scale will be set to be from 0 to 
100 %.

When F/F0, R(t) or F/F(t0) is disabled, autoscaling will 
be enabled and performed on both X- and Y-axis to 
adapt to the complete data set.

When F/F(t0) is enabled, cursors for t0 and F0 are not 
displayed.

9.4.21 Zoom 

There are several ways of selecting what timeframe 
or value range to view. The easiest is to use the zoom 
functions, which are accessible from the graph tools 
below the graph. Select from the following images to 
zoom in or out.

Zooms in an area of the graph. Click and drag a 
selection in the graph to zoom.

Zooms in an area of the graph on the x-axis. Click 
and drag a selection in the graph to zoom.

Zooms in or out to autoscale the graph.

Selects the cursor tool to enable moving cursors 
by dragging them. Selects the cursor tool to enable 
moving cursors by dragging them.

9.4.22 Set scale range
The scale range can be manually set by clicking on either 
of the scale’s maximum or minimum value and changing 
that value to the desired maximum/minimum for that 
scale.  For scales other than absolute time, it is also 
possible to enter the max/min scale value as SI-prefixes, 
e.g. 1M, or scientific notation, e.g. 1e6. When editing 
absolute time min/max range, the easiest is to just 
change the part you need to change by selecting it, since 
the format of the time needs to be correct to be accepted.
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9.4.23 Setup graph axis
The X-axis can be set to logarithmic scale by ticking 
Logarithmic time above the graph. The default time 
scale minimum is 0,1 h to accommodate most common 
t(F0) values, but you may want to change the scale 
minimum value to match what is displayed (see Set 
Scale Range). 

By right-clicking the graph area, you will access a 
number of graph axis settings, e.g. auto scaling and 
logarithmic scale.

If you disable (untick) a Y-scale, the scale will not be 
displayed, and no values for that scale will be displayed.

9.4.24 View evaluation points
The evaluation points for a selected item can be viewed 
by clicking on Evaluation points or by right-clicking 
on a group and selecting Evaluation points, which will 
open a window with a table and graph of the evaluation 
points for that group. If no item is selected and only one 
file is opened, that group’s evaluation points will open. 
If nothing is selected and multiple files are opened, the 
evaluation point window will not open.

9.4.25 Editing evaluation points
To add an evaluation point, open the evaluation point 
viewer (see View evaluation points), scroll to the end of 
the table and add a new time entry in an empty field. The 
time value needs to include the colon separating hours 
and minutes for the value to be accepted and both hours 
and minutes needs to be specified.

If the visible part of the table is filled with data, instead 
click the plus sign  to the left of the lower left corner 
of the table to add a new point. A new point with the 
same time as the one last in the table will be added.

To remove an evaluation point, click the minus sign    
to the left of the selected entry.

To modify the time for an evaluation point, select that 
time entry and modify the time by entering a new time, 
or by selecting either the hours or minutes and changing 
that part of the time entry.

The evaluation point table will be recalculated when any 
information in the table is changed.

The evaluation times will be sorted as soon as any 
change affects that data. Duplicate evaluation points 
are not automatically removed since you may want to 
change the values and may have entered a duplicate 

value that would then disappear. Values 
can be changed by selecting a value and 
using the keyboard arrows or mouse scroll 
wheel. If you change a value, the value 
will be unselected if the change causes a 
resort of the evaluation times, so you do 
not accidentally continue to change another 
value.

9.4.26 Evaluate 
by R(t) or F/F0
To calculate a time 
for a specific R(t) 
or F/F0, open the 
evaluation point 
viewer (see View 

evaluation points) and modify the specific entry of either 
a R(t)- or F/F0-value. The time-value will be updated 
from it. The time that matches the specified value will be 
used for time and R(t) and F/F0 will be calculated from 
it. The resulting calculated F/F0- or R(t) value can differ 
slightly to what was specified since the time is calculated 
from a mean time for the relaxation for each station in 
the group (and the median relaxation for the group is 
then calculated for that mean time).

9.4.27 Evaluate according  
to ISO 3384 Method B
To use temperature as evaluation point, open the 
evaluation point viewer (see View evaluation points) 
and tick ISO 3384 Method B. The default temperature 
and tolerance for IS0 3384 are already specified but can 
be changed by modifying the temperature at which the 
evaluation points shall be calculated from in Target, and 
the maximum difference from the specified temperature 
at which to evaluate in Tolerance. An evaluation 
point will be set at every time the temperature criteria 
is fulfilled, at the last point before the temperature 
changes. If the test data ends at the target temperature, 
an evaluation point will be set at the median offset time 
used for all other temperature evaluation points.
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9.4.28 Save and recall  
evaluation settings
To save the evaluation settings to an evaluation point 
specification file, open the evaluation point viewer (see 
View evaluation points), click Save and choose a file 
name and location to save the file to. Click Open to open 
a previously saved file and populate the settings from 
that file into the evaluation point viewer. The evaluation 
points will immediately be recalculated based on the 
loaded file’s evaluation settings. Use this feature to reuse 
common evaluation points and to be able to compare 
files that do not have the same evaluation points 
specified in its log data file. Just load the evaluation 
specification file for each Relaxation log data file you 
wish to compare. When printing, the evaluation points 
will then be the same and the median value for those 
files will be calculated. The edited evaluation points will 
not be saved to the log file.

9.4.29 Add annotations
Annotations can be used e.g. to label a group of plots 
or to highlight an occurrence of interest in the graph. 
Annotations will be visible in the printed report but 
will not be saved to the log file. To create annotations 
in the graph, click Annotate above the graph. Click 
Add in the window that opens, type in your annotation, 
click OK, optionally choose the size of the annotation 
(small, medium or large) and click OK. In the graph 
you can click and drag your annotation to place it. 
Keep the annotation short since all text in the same 
annotation will be on one line. Annotations can also 
be moved around in the print preview window. Open 
the annotation window to edit, delete, change size on 
or add more annotations. To edit an annotation, click 
Annotations… and double-click on its name in the 
Annotations window.

9.4.30 Autoscale
The application will by default autoscale both time and 
value (X and Y). To disable autoscale, untick either 
Autoscale Y-axis or Autoscale X-axis. These tick-boxes 
are available above the graph. Autoscale is turned off if 
scale is set manually by zooming or setting a scale range 
manually (See section Set scale range).

9.4.31 Print report
Press CTRL+P or go to the file menu and select Print to 
open the print preview window.

There are two types of reports, and a dialog will ask 
which type you want: Table & Graph or Graph only.

	 1.	 Table & Graph: Prints a table of evaluation  
		  points, a graph, and details about the tests for the  
		  items you have selected in the tree. A total of three  
		  stations can be printed. If more stations are  
	 	 selected to be printed, the three first selected  
		  stations will be used. Add to the selection by  
		  holding CTRL pressed while clicking. 

	 2.	Graph Only: Prints a graph as displayed on the  
		  graph, regardless of what is selected. 

For both report types, only enabled/ticked stations’ 
plots will be visible. So, if you untick a station but tick a 
sensor plot in that station, that plot will not be visible in 
the report.

The graph in the report will be set up in the same way 
as the main window’s graph is set up. So, if you want to 
display the report using log scale, F/F0 or use a specific 
plot point style, just set it up on the main window’s 
graph and then open the print preview.

In the print preview window, the report header can be 
changed by simply clicking on and editing the header 
text.

Click Print to print the report. Windows’ default printer 
dialog will open. If you need to print to a PDF, newer 
version of Windows usually has that pre-installed as a 
printer, or a PDF printer can be installed. If you need to 
print to an image file, PDF viewers often have the ability 
to print the PDF as an image. It is also possible to install 
a virtual picture printer to print to an image file.

Click Save as image to save the report as an image file.

The name of the plots will be displayed on the graph 
with cursors attached to the plot. The plots are named 
with grade name and rig name, and filename if multiple 
files are in the report. These cursors can be moved freely, 
and the names can also be moved independently of the 
cursors. The cursors and names can also be hidden by 
right-clicking on the graph and untick the plot you don’t 
want to display the cursor and name for, or by clicking 
Hide all cursors. A cursor name can be changed by 
double-clicking on the name. 

The name(s) of the file(s) can be edited.

To hide the graph scale grid, right-click on the graph and 
click on Show grid to untick it.
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Report header details

	 –	 File(s): Displays the file(s) name(s) the report data  
	 	 originates from. A maximum of three files will be  
	 	 listed. If more than three files are used, the first  
		  selected three will be listed.

	 –	 RP(F0): Physical relaxation between t0 and F0.

	 –	 Stop time: Time since start until end condition,  
	 	 if a specified end condition has been met. If the  
		  end condition has not been met, the total test time  
		  is reported.

The evaluation point table in Table & Graph will include 
up to 10 evaluation points. If there are more points, 
the 10 points will be picked evenly distributed from the 
evaluation points list by index (not by time).

9.4.32 Display evaluation plot in report
Enable F/F0 or R(t) in the main window’s graph and 
select to print as explained in the section Print report. 
Table & Graph will now display a plot for the evaluation 
points. Hide the evaluation plot by unticking Plot 
evaluation points or by unticking Evaluation points 
(median) in the graph’s right-click menu.

To hide all plots but the evaluation data, right-click on 
the graph and untick Data plots.

To hide the evaluation data, right-click on the graph and 
untick Evaluation points (median). 

The Graph only report can also display a plot for 
evaluation data. Enable it by ticking Plot evaluation 
points or by ticking Evaluation points (median) in 
the graph’s right-click menu. The evaluation data is a 
median per evaluation point of all displayed plots, and 
all evaluation points for all plots will be used in the 
evaluation plot. The plots do not even have to be of the 
same length (time), but evaluation data will only be 
plotted for points where all plots have data.

9.4.33 Export data
Click Export or press CTRL+E or go to the file menu and 
select Export to export the currently selected item(s)’ 
file(s). If no item is selected and only one file is open, 
that file will be used for the export. If nothing is selected 
and multiple files are opened, nothing will be exported. 
A text file will be created for each log file with all the log 
file data and calculated F/F0, and you will be prompted 
where to save the file(s) and to name them. The file 
name is already suggested using the logfile’s file name. 
The exported file can easily be imported into e.g. Excel 
or database systems.

9.4.34 Set export time format
The time format of the export can be either in 
HH:MM:SS (e.g. 12:45:30), or in decimal hours (e.g. 
12.4567). To change this setting, press CTRL+I or go to 
the Edit menu and select Settings…. Click on the desired 
time format and click OK to apply.

9.4.35 Set report logo
To set a logo to be printed in the upper right corner 
of the report, open the settings window by pressing 
CTRL+I or go to the Edit menu and select Settings…. 
Click Browse and select a picture file to use as logo. The 
picture size must be at most 125×125 pixels. The logo 
will display in the New logo frame so you can preview it 
and compare it to the current logo. Click Apply new logo 
to use the new logo.

To have the logo show in the report, make sure that Use 
logo in report is ticked. Click OK to apply the settings.
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9.4.36 Tips
•	 To see more or less of the tree or graph, drag the  
	 splitter between the tree and graph.

•	 The application supports standard Windows inputs  
	 like e.g. Shift/CTRL and click to select multiple items,  
	 arrow keys to move cursor or selection, and  
	 combining Shift/CTRL with arrow-keys to select  
	 word(s) or parts of data.

•	 The mouse scroll wheel can be used to increment or  
	 decrement selected values.

	 –	When a numeric value is selected, the digit to  
		  the left of the location of the cursor will change  
		  when scrolling.

	 –	When a time value is selected, the selected part will  
		  increment/decrement.

	 –	Some controls have a minimum step size, so  
	 	 positioning the cursor to a less significant digit will  
		  still increment by the minimum step size.

•	 Press Escape to close a dialog or window, cancelling  
	 any change.

•	 An exported file can simply be dragged from Window’s  
	 file explorer into Excel to be imported correctly.

•	 If a text is longer than the column width in the tree  
	 view, hover over an item to display the complete text  
	 in a tip strip:

9.4.37 Troubleshooting

Symptom
	 Temperature data displays 850 °C and force displays  
	 4,3 N.

	 Probable cause
	 A file that contains a station that has been run but  
	 was not connected during the measurement will  
	 display values at the end of the range for the sensor.  
	 For a standard temperature sensor, the temperature  
	 will then display 850 °C and force will display about  
	 4 N.

	 Solution
	 Either create a user configuration in which that  
	 station is not included or to have the station  
	 connected even if it is not used.

Symptom
	 Too many evaluation points for ISO Method B. 

	 Probable cause
	 The specified temperature is not at the actual  
	 temperature used in the measurement, or the  
	 temperature was not stable during measurement.

	 Solution
	 Change the target temperature to the correct  
	 temperature or adjust the tolerance.

Symptom
	 The F/F0 values are off by a lot compared to expected  
	 values when evaluation using ISO Method B is used. 

	 Probable cause
	 The measurement was not started at the target  
	 temperature (default 23 °C) or t(F0) is set at a time  
	 where the temperature is not at the target  
	 temperature.

	 Solution
	 Make sure t(F0) is at a time where the temperature  
	 has not changed since t0. Start the measurement at  
	 target temperature.

9.5 Calibration procedure
The procedure is the same regardless if no measure
ments are running, if another rig than that of the logging 
groups shall be calibrated, or if an actively logging rig 
is to be calibrated. There are more advanced ways of 
performing the calibration, but this describes a basic 
procedure which Elastocon recommends for most users. 

	 1.	Exit the application without stopping the ongoing  
		  measurements, by either closing the application  
		  window, pressing CTRL+Q or going to the file menu  
		  and selecting Exit. (Advanced users may want to  
		  keep the application opened, but it is not described  
	 	 here how that would affect the procedure.)

	 2.	From the HWConfig application, open C:\ 
	 	 ProgramData\Elastocon\Relaxation EC05\ 
	 	 Stations\StationsConfig.tvc.

		  NB! Do not open the file using “Load as template…”.  
		  If you have, do not save it. This is an advanced  
		  feature that normal users shall not use, and  
		  which will make it impossible to continue any  
		  running measurements.
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	 3.	Perform the calibrations for temperature and force:

	 	 In the main view of the HW Config application, in  
	 	 the tree view containing the configuration, select  
		  the line with the sensor you want to calibrate. Click  
		  on Live adjustment to display the A/D and output  
		  value of the sensor. Read the sensor output value  
		  for your selected calibration points, and if needed  
		  change the value in the adjustment table. It  
		  is possible to change either the A/D value or the  
		  corresponding sensor value until the A/D and  
		  sensor values are what you want. Typical acceptable  
		  deviation limits are normally 1 °C for temperature  
		  and 1 % relative error for force.

		  The adjustment table values should always span  
		  the range for which you shall use the sensors. There  
		  is no built-in warning if the sensor is used outside  
		  of its calibrated range, and the resulting values  
		  will be extrapolated from the calibrated values, so  
		  the accuracy cannot be determined if used outside  
		  the adjustment table range.

		  There are more advanced calibrations and settings  
	 	 that can be made from the HW Config application,  
		  but these should only be performed by a calibration  
		  technician trained by Elastocon.

	 4.	Save the file. Replace the same file. Do not save as  
	 	 a new file. 

	 5.	Run the Relaxation application. The new calibration  
		  data is now loaded, and the newly calibrated rigs  
		  can be used. 

	 6.	Continue any running measurements (see section  
		  9.3.4.3).

		  NB! If there are ongoing measurements, do not  
	 	 change the user configuration for those groups  
		  during this procedure, since the ongoing  
	 	 measurements requires the user configuration for  
		  that group to be the same as when it was started. If  
		  there are ongoing measurements, do not load  
	 	 another user configuration file using Load to Log,  
		  since that may also make it so that measurement  
		  cannot be resumed.
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Note: Always follow the standard applicable, these 
instructions are only guidance.

1.	 If applicable, perform the thermal conditioning,  
	 measure the thickness of the test pieces, and  
	 perform the mechanical conditioning according  
	 to the applicable test standard.

2.	 Start the oven and adjust the temperature, both  
	 for the cells and the hood.

3.	 Start the Relaxation application. If you already  
	 have a user configuration for the rig setup, click  
	 on the Log tab in the upper left corner of the  
	 application window. If you do not have a user  
	 configuration, create and save the configuration  
	 you want to use, and click Load to Log. Remember,  
	 the calculations will be performed as a median value  
	 for the whole group. You can have a maximum of  
	 3 rigs/group, and the report prints maximum 3 rigs  
	 in the same report.

4.	 Put the clean rig in the cell for pre-heating and  
	 connect it to the amplifier box.	

5.	 Choose Log view, right click on the rig and select  
	 Setup.

	 a.	 Make sure the correct test method is chosen,  
		  compression or tension.

	 b.	 Fill in the data about the sample.

	 c.	 Fill in the grade name and if you like to, also  
		  a comment.

6. 	 Right click on the group and choose set up.

	 a.	 Enter the operator name or ID if you want to keep  
		  track of who performed the test. 

	 b.	File identifier – this will be a part of the file name 
		  together with the date. 

	 c.	 Comments: optional, could be e.g. temperature,  
		  environment, batch number etc.

	 d.	Logging intervals: the default means, that for  
	 	 the first 30 (or recommended) 60 minutes the  
		  logging will take place every (1) time unit that  
		  is chosen in sample interval (s) e.g. 30 seconds.  
		  This means that logging will take place twice  
		  every minute. After 30 (or 60) minutes and  
		  until 1440 minutes from start (24 hours) the 
		  logging will take place every 2nd this time unit  
		  takes place (that is, one time each minute) and  
	 	 for Infinitive every 60th time unit, that is once  
	 	 every 30 minutes. If you log too often the file  
		  will be very big.

	 e.	 Stop time: If you want to set a stop time for the  
		  test. E.g. one week is 168 hours. 0 = never stop. 

	 f. 	Set a value for F/F0 tolerance if you want to  
		  display a dialog box when the F/F0 value is  
		  reached for all stations in this group, allowing the  
		  user to stop or continue. A value of 100 means  
		  that there is no counterforce.

7.	 Click OK. In the log view, fill in evaluation points.

8.	 When the rig is preheated, adjust the temperature  
	 of the hood, and choose a temperature 2 degrees  
	 lower than it shows without the cooling activated.

9.	 Right click on the rig and select Open. 

10.	 Zero the rigs:

	 a.	 For compression: Check that the dial gauge  
		  is zero when the platens are together (with  
		  approximately 10 N force applied) and zero  
		  the position. Then raise the upper platen a  
		  couple of mm and go back down 0,5–1 mm  
		  approximately, then you zero the force.

	 b.	 For tension: Set the free distance between  
		  the clamps to 50 mm, make sure you turn the  
	 	 clamp first up and are in a down motion when  
		  you reach the 50 mm, zero the position and  
		  the force.

11.	 Remove the rig from the cell in the oven.  
	 (Hint: Try to keep the rig inside the oven as much  
	 as possible to remain most of the heat. You save  
	 a lot of time this way.)

12.	 Mounting the sample:

	 a.	 For compression: Lubricate the sample.  
		  Place the sample in middle of the platen, add  
		  a small preload of approximately 10 N to the  
		  sample. Place the rig back in the cell oven.

	 b.	 For tension: Turn the screw 1 revolution  
		  downwards to make the free distance 49 mm  
		  while mounting your samples. Clamp the  
		  sample securely in both the upper and lower  
		  clamp, make sure you place the sample against  
		  the bottom of each clamp. Raise the upper rig  
		  1 mm/1 full turn/resolution with the screw.  
		  Now your sample should be straight and not  
		  dented. Place the rig back in the cell oven.

10. Step by step instructions  
for running a stress relaxation test
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13.	 When the temperature is correct/stabilized, right  
	 click on the group and choose start or use the  
	 button at the top of the window to start the test.

14.	 Open the rig by right clicking on it and choose  
	 Open, here you can find the values for your  
	 compression and elongation. Either compress or  
	 stretch the sample, remember that one revolution  
	 on the screw is equal to 1 mm in position.

15. Make sure you have marked the correct rig (not  
	 group) and click the box for the t0, and drag the  
	 line to the right point (or you could write in the  
	 exact time in the box). 

16.	 t(F0) is the time for the initial force and according 
	 to standard is 30 minutes for compression and  
	 5 minutes for tension. This is set to minimize the  
	 physical relaxation on the result.

	 The measurement will start after this to ensure  
	 you measure the true ageing effect (for tests at  
	 room temperature the effects of the physical  
	 relaxation can go on for weeks).

17.	When the test is finalized, mark the correct group  
	 and stop the test in the Log view (either use the  
	 stop button or right click on the group and choose  
	 stop).

	 NB! Only stop groups that for certain shall not run  
	 any longer. Stopping a group finalizes the log file  
	 and such a file cannot be continued on.

Presentation/Report Presentation view
18.	 Open Relaxation Viewer software, choose File  
	 and Open those files you like to compare/look at.

19.	 Check the box for relative time if you like to  
	 compare different files.

20.	 You can change the scales on the axis if you like  
	 to, unmark the box automatic scale and just type  
	 in new values at the end point of the axis.

21.	 You can print this, or you can export the data to a  
	 text file which can be opened in a spreadsheet  
	 software such as Excel or Open Office, if required.

For more information about these steps, please read the 
corresponding chapter in the manual.
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Appendix – What is the load cell strain compensation? 
Shortly described, the strain 
compensation in the load cell is 
a calculated factor you will get 
when you measure how much 
the load cell is compressed 
(deformation) in µm at 
maximum force. This is the 
load cells normal working area 
and without this the load cell 
would not be able to function. 
The factor you receive is then 
recalculated to mm/Newton. 

A typical deformation of the load cells for Elastocons 
relaxation rigs is 0,00055 mm/N. This may sound like a 
very small deviation, but during an actual measurement 
this can cause differences in tens of N, depending on 
start force and how big/quick the decreasing of the force 
is during the test. The load cell’s strain compensation 
value will not change for a load cell during normal 
usage. Only if the load cell is overloaded or dropped (e.g. 
on the floor) and have a permanent deformation (plastic 
deformation) but still works, it may be relevant to make 
a new measurement for the strain compensation. 

What happens during a measurement is that the load 
cell length is extended when your material is relaxing 
(chemical and mechanical/physical). You can say that 
the load cell to some extent is compensating for the 
relaxation in your material and you will get a better 
result for your material compared to the reality. 

To avoid the influence from the load cell on your test 
result, choose to use the load cell strain compensation 
when the software asks you. 

In the software, both for an opened measuring file and 
for export or print outs the current status about strain 
compensation will show, that is, if it is used or not. 

The strain compensation is always on in the logging 
view in the software. But in the presentation view it 
is possible to choose a view with or without the strain 
compensation.

Appendix – Drawings EB02 and EB 02TE
Following pages.
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